
WINDOW BASICS



Minimize a window

 By moving the mouse pointer to the 
minimized button (▼) the down arrow in the 
upper right hand corner of the window and by 
clicking it, the window becomes an icon at 
the bottom of the Desktop(i.e. window 
reduces to an icon). From the bottom of the 
screen, you can click the icon at any time and 
make the window active because at the 
bottom the minimize icon is in ready state.



Maximize a window

 On maximizing the window, the window 
takes up the whole desktop. When you 
maximize a document window, it expands to 
take up the entire application window. This 
may or may not be the entire screen, 
depending on whether the application has 
been maximized. To maximize the window, 
move the mouse pointer to the maximized 
button (▲) and by clicking it, the window 
expands to fill the entire screen.



Exit window

 To exit a window and to make it disappear 
from the screen either click the cross (X) 
button in the small box on the right upper 
side of the title bar of the window or by 
choosing the close command from the file 
menu of the window. You can also exit a 
window from the keyboard by pressing Alt + 
F4 key combination. By exiting from 
keyboard current opened window will be 
closed automatically.



File management through windows

 Copying files - Various steps to copy the 
contents of file or folder into another are:
1. Click on my computer icon and find the location of 

your file or folder which you want to copy
2. Click copy button from the toolbar or choose edit 

menu-bar, click on copy option or you can also press 
CTRL+C key.

3. Open the folder or drive where you want to place the 
file or folder which has been copied

4. Click the paste button from toolbar or choose edit 
menu-bar, click paste option or you can also press 
CTRL+V key.

5. Window will paste the desired file or folder



 Moving files - Various steps to move the file 
or folder from one location to another are:
1. Click on my computer icon and find the location 

of your file or folder which you want to move

2. Click cut button from the toolbar or choose edit 
menu-bar, click on cut option or you can also 
press CTRL+X key.

3. Open the folder or drive where you want to 
place the file or folder which has been cut

4. Click the paste button from toolbar or choose 
edit menu-bar, click paste option or you can also 
press CTRL+V key.

5. Window will paste the desired file or folder



 Deleting files or folders : The following are 
the various steps to delete file or folder:

1. Click on my computer icon and find the location 
of your file or folder which you want to delete

2. Click delete button from the toolbar or choose 
edit menu-bar and click on delete option to 
delete the file or folder.

3. A message for the confirmation appears asking 
you “Are you sure you want to delete this file?”

4. Click yes if you want to delete the file and no if 
not.

5. The deleted file will be moved to recycle bin as 
we already know.



 Creating a directory/folder : Various 

steps to create a folder are:

1. Double click on the computer icon on the desktop

2. Double click the location i.e. drives where you want 
to create a folder

3. Choose the file menu bar and select new option from 
the menu or right click the mouse button and choose 
new option and from pop menu select folder option 
to create a folder or directory

4. By default the name of the folder is “New folder” so 
if you want to change the name of the folder, right 
click it select rename and change the desired name.



 Renaming a directory or folder: 

Various steps to rename a folder or directory 
are:

1. Click on my computer icon and find the location 
of your folder or directory which you want to 
rename

2. Left click the folder or directory and choose the 
file menu bar and from pop up menu choose 
rename command or you can right click the 
mouse onto folder or directory and choose 
rename option



Use of help feature

 The help and support option takes you to 
complete online help for the users. We can 
search the help database to find answers to our 
queries about working in windows, different 
application, utilities and troubleshooting 
devices. Just type your query in the text area and 
click search button to search for the relevant 
topics. You can also select a topic from PICK A 
HELP TOPIC. You can even get support from 
windows support site through internet.



Starting an application

 Various methods to start an application in 
windows are:

 Click on the start menu and in the pop up menu 
click on Programs, and choose the application you 
want to run from the pop up menu, or in the 
subdirectory of the listed folders.

 If the application icon is on the desktop, then you 
can double click the icon to start the application.

 You can also right click on the application icon and 
choose RUN or OPEN



Essential accessories

 To access the accessories you have to 
perform the following steps:

 Click on start button

 Select programs option

 A cascading menu appears containing number of 
applications and select Accessories

 Another cascading menu appears having number 
of small applications



 Various applications are:

1. Communication: Under this, the options like dial-up 
networking, direct cable connection exists. This option 
is used to establish link between various computers

2. Entertainment: Under this menu, the options like 
volume, cd player exists.

3. Games: Under this, various games like Solitaire, 
minesweeper, free-cell exists.

4. Calculator: It is used to perform various calculations. 
You can perform various math function just by typing 
them on calculator window. You can press various 
buttons on the calculator window to perform 
operations like addition, subtraction, multiplication, 
division etc.



 Various steps to open calculator

 Click on the start button

 Choose program option and then accessories

 Select calculator option from the pop up menu

You can also go to the start button, and choose RUN 
and type CALC to run the calculator.



5. Notepad

 Notepad is an application program used to 
prepare various text documents. You can also use 
notepad to write your html documents to be 
uploaded on website. 

 Various steps to open notepad
 Click on the start button

 Choose program option and then accessories

 Select notepad option from the pop up menu

You can also go to the start button, and choose RUN and 
type NOTEPAD to run the notepad.



 Various menu bars available in notepad are:

 File: It contains the commands for opening, 
closing, saving the file.

 Edit: It contains the commands to perform cut, 
copy, paste and delete.

 Format: It contains the options of word-wrap and 
fonts.

 View: It contains the options for viewing the 
status bar.

 Help: It contains the help topics of notepad.



6. Paintbrush

 It is an application program used to prepare 
various graphics documents. Various tools 
available in paint help to apply these on the file 
being prepared. Basic format for the paintbrush 
file is .BMP (bitmap image)

 Various steps to open paintbrush
 Click on the start button
 Choose program option and then accessories
 Select paintbrush option from the pop up menu

You can also go to the start button, and choose RUN and 
type MSPAINT to run the paintbrush.



7. Wordpad

 It is basically used for creating the text documents of any 
kind. It is known as a word processor produced by 
microsoft. With the help of various tools available in it, we 
can format our text documents. After creating a text 
document we can format it with a number of tools and we 
can also take the print outs of the documents.

 Various steps to open wordpad
 Click on the start button
 Choose program option and then accessories
 Select wordpad option from the pop up menu

You can also go to the start button, and choose RUN and type 
WORDPAD to run the wordpad.



Opening and using Wordpad

 You can open wordpad by the following ways:
Method 1:

Double click on the wordpad icon on the desktop

Method 2:

1. Take the mouse pointer to the start button on 
the task bar. Click the left mouse button.

2. Move the pointer to the programs. You will 
notice another menu coming up to the right.

3. Under that menu, go to accessories, and in the 
pop up menu you will find wordpad.



 Main menu options:
 File: You can perform operation by using these 

options such as opening, closing, saving, printing 
exiting.

 Edit: Under this option you can perform editing 
functions such as cut, paste, find and replace.

 View: Under this option you can enable or disable 
toolbar, status bar, ruler, format bar.

 Insert: Under this menu you can insert date/time 
and object.

 Format: Under this menu, you can set font, 
paragraph, bullets and tabs.

 Help: Under this menu, you can check for help 
topics.



Opening and using Notepad

 You can open notepad by the following ways:
Method 1:

Double click on the notepad icon on the desktop

Method 2:

1. Take the mouse pointer to the start button on 
the task bar. Click the left mouse button.

2. Move the pointer to the programs. You will 
notice another menu coming up to the right.

3. Under that menu, go to accessories, and in the 
pop up menu you will find notepad.



 Main menu options:

 File: You can perform operation by using these 
options such as opening, closing, saving, printing 
exiting.

 Edit: Under this option you can perform editing 
functions such as cut, copy, paste, find and 
replace.

 Format: Under this menu, you can set font and 
word-wrap.

 View: Under this option you can enable or disable 
status bar.

 Help: Under this menu, you can check for help 
topics.



Using different windows simultaneously

 You can open multiple windows simultaneously in 
windows and can work on multiple windows at the 
same time without losing data of one window.

 You can minimize one working window, and open, 
maximize or restore the other window.

 The minimized window rests on tool-bar till we click 
on it to restore or maximize it.

 You can use ALT-TAB to switch between different 
windows and/or applications.

 You can also right click on the task bar and check 
various options to manage windows like Cascade 
windows, Tile windows horizontally and Tile 
windows vertically.



Using Paint

Paint is a program used to draw, color, and edit 
pictures. You can use Paint like a digital 
sketchpad to make simple pictures and creative 
projects or to add text and designs to other 
pictures, such as those taken with your digital 
camera.

The parts of Paint

 To open Paint, click the Start button , click All 
Programs, click Accessories, and then 
click Paint.



 When you start Paint, you see a window that 
is mostly blank, with just a few tools for 
drawing and painting.

 Working with tools

 Paint includes a handy collection of drawing 
tools in the toolbox. You can use these tools 
to create freehand drawings and add a 
variety of shapes to your pictures.

 This section describes some common tasks. 
For information on how to use each tool in 
the Paint toolbox, see Paint tools.

http://windows.microsoft.com/en-US/windows-vista/Paint-tools


 Draw a line

 Some tools, like the pencil, brush, line, and 
curve, let you make a variety of straight, 
curved, and wiggly lines. What you draw is 
determined by how you move the mouse as 
you draw. You can use the line tool to draw a 
straight line, for example.

 In the toolbox, click the Line tool .

 In the Color box, click the color you want to 
use.

 To draw, drag the pointer across the drawing 
area.



 Draw a squiggly line

 Your drawings don't have to be composed of 
just straight lines. You can use the Curve tool 
to create smooth curves, for example. The 
Pencil and Brush can be used to make 
completely random, free-form shapes.

 In the toolbox, click the Pencil tool .

 In the Color box, click the color you want to 
use.

 To draw, drag the pointer across the drawing 
area



 Draw a shape

1. Some tools, like the Rectangle and ellipse, let 
you add shapes to your drawing. The technique 
is the same regardless of which shape you 
choose. For example, you can use 
the Polygon tool to draw a polygon, which is a 
shape that can have any number of sides.

2. In the toolbox, click the Polygon tool .

3. In the Options box, click a fill style

4. Outline. Your shape will be just an outline, with a 
transparent interior.



 Outline with fill. Your shape will be filled with 
the current background color. (To set a 
background color, in the Color box, right-click a 
color.)

 Solid. Your shape will be filled with the current 
background color, but it will not have any 
outline.

 To add a polygon, drag the pointer across 
the drawing area, and then click to end the 
first side.

 Drag the pointer to create the next side, and 
then click to end the side. Repeat this as 
needed for additional sides.



 To create the final side and close the polygon, 
double-click.

 Erase part of your picture

 If you make a mistake or simply need to change 
part of a picture, use the eraser. By default, the 
eraser changes any area you erase to white, but you 
can change the eraser color. For example, if you set 
the eraser color to yellow, anything you erase turns 
to yellow.

 In the toolbox, click the Eraser tool .

 In the Color box, right-click the color that you want 
to erase with. If you want to erase with white, you 
don't have to select a color.

 Drag the pointer over the area you want to erase.



 Changing the effect of the drawing tools

 The Options box, located below the toolbox, is 
where you can change how a tool draws. You 
can set the thickness of the tool's brush (which 
affects the weight of what you draw on the 
screen) and whether the shapes you draw are 
outlined or solid.

 Change the brush stroke of the Brush

 In the toolbox, click the Brush tool .

 In the Options box, click the brush shape you 
want to paint with.

 To paint, drag the pointer across the drawing 
area.



 Saving a picture

1. Save your picture frequently to ensure that you 
don't accidentally lose your work. To do that, on 
the File menu, click Save. This saves all of the 
changes you made to the picture since the last 
time you saved.

2. The very first time that you save a new picture, 
however, you will need to give your picture a file 
name. Follow these steps:

3. On the File menu, click Save.

4. In the Save as type box, select the file format you 
want.

5. In the File name box, type a name.

6. Click Save.



Format Text in Wordpad
 Formatting your document

 Formatting refers to the how the text in your 
document looks as well as how it is arranged. 
WordPad lets you easily change the formatting 
in your document. For example, you can choose 
from many different fonts and font sizes, and 
you can make your text almost any color you 
want. You can also easily change how your 
document is aligned



 To change the font, font style, or font size

1. Select the text whose formatting you want to 
change.

2. On the Format menu, click Font.

3. In the Font box, type or select the font you 
want to use.

4. In the Font Style box, type or select the font 
style you want.

5. In the Size box, type or select the size you 
want to use.



 To change the color

1.Select the text whose color you want to 
change.

2. On the Format menu, click Font.

3. Under Color, click the color that you want.



 To change the alignment

1. You can align the text in your document (or a 
paragraph in your document) to either the 
left margin, the center, or the right margin.

2. Select the paragraph whose alignment you 
want to change.

3. On the Format menu, click Paragraph.

4. In the Alignment box, click the alignment 
you want.


